
S E C O N D  E D I T I O N

XTINE BURROUGH

DIGITAL ART  
DESIGNAN

D

with
ADOBE CREATIVE CLOUD

of

Sam
ple

 p
ag

es



CONTENTS
Introduction  xi

SECTION 1:

BITS, PIXELS, VECTORS, AND DESIGN
CHAPTER 1: THE DOT, THE PATH, AND THE PIXEL  •  9
Paths and Vector Graphics  12
Pixels and Bitmap Graphics  12
Exercises

1.	 File Presets in Illustrator  13
2.	 Shapes, Fills, and Strokes  14
3.	 Figure and Ground with Repeated Dots  17

Screencast 1-1: The Pattern Brush  19
4.	 Grouping and Alignment  19
5.	 A Figure and Ground or “On” and “Off” Study  22

Lab Challenge  22

CHAPTER 2: DRAWING EXPRESSIVE LINES  •  23
Saving and Sharing Files  27
Exercises

1.	 Place and Lock an Image  29
2.	 Understand Layers  31
3.	 Create Lines with the Pencil Tool  32
4.	 Duplicate the Composition  34
5.	 Add a Gradient Background  36
6.	 Create Depth with Contrasting Values  38

Screencast 2-1: Add the “Swoosh” at the Horizon  39
7.	 Use Master Files and Shared Files  41

Lab Challenge  42

CHAPTER 3: MODIFY BASIC SHAPES  •  43
Signs and Logos  46
Vector Curves  46
Exercises

1.	 Create a Document with One Artboard and Set Guides  47
2.	 Combining Shapes  50
3.	 Duplicate the Artboard and Add Anchor Points  53
4.	 Convert Anchor Points from Straight Edges to Curves  56

Screencast 3-1: Modify Paths with the Pen and Direct Selection Tools  58
5.	 Reflect and Copy a Shape  58
6.	 Save a Multi-page PDF  60

Lab Challenge  61

Contents  v

Sam
ple

 p
ag

es



SECTION 2:

DIGITAL PHOTOGRAPHY
CHAPTER 4: CREATING AND ORGANIZING  
DIGITAL PHOTOGRAPHS  •  67
Measuring Light  70
Rule of Thirds  70
Adobe Bridge  71
Exercises

1.	 Camera Mechanics  72
2.	 Camera Settings  73
3.	 Bracketing  78
4.	 Before You Shoot  79
5.	 Rule of Thirds  80
6.	 Bridge Workspaces  82
7.	 Batch Rename  85

Screencast 4-1: Renaming and Ranking Files in Bridge  88
8.	 Generate a PDF to Showcase Your Files  88

Lab Challenge  90

CHAPTER 5: RESOLUTION AND VALUE  •  91
Redistributing and Resampling Pixels via Resolution  92
Value and the Tonal Range  93
Zone System Redux  95
Exercises

1.	 Redistribute Pixels for Print Resolution  97
2.	 Resample Pixels for Screen Resolution  99
3.	 Analyze a Photograph Using the Zone System  101

Screencast 5-1: Use the Info Panel to Check Your Eye Against  
Image Data  104

4.	 Modify the Tonal Range with a Levels Adjustment Layer  106
Lab Challenge  110

CHAPTER 6: COLOR MODELS  •  111
Subtractive Processes  112
Additive Processes  113
Exercises

1.	 Harmony in Rectangles with Adjustment Layers for Hue/Saturation  118
2.	 Simultaneous Contrast in Circles  123
3.	 Color Comparison  127
4.	 Color Correction with Adjustment Layers for Levels and Curves  127

Screencast 6-1: Applying Color to a Black-and-White Photograph  132
5.	 Color Correction in Adobe Lightroom Classic  132

Lab Challenge  135

vi  FOUNDATIONS OF DIGITAL ART AND DESIGN WITH ADOBE CREATIVE CLOUD

Sam
ple

 p
ag

es



SECTION 3:

DIGITAL MANIPULATION AND FREE FAIR USE
CHAPTER 7: REPAIRS AND HOAXES  •  145
Digital Repairs  146
Creating a Hoax  147
Exercises

1.	� Remove Dust and Heal JFK’s Blemishes with the Develop panel in  
Adobe Lightroom Classic  149

2.	 JFK’s Eyes: Tonal Repairs with Dodge and Burn  155
Screencast 7-1: Adding and Deleting within Selections  157

3.	 It’s a Hoax! Adding an Extra Mummy Finger  160
4.	 Softening Cloned Edges  162

Lab Challenge  164

CHAPTER 8: SELECT, COPY, PASTE, COLLAGE  •  165
Precision Selecting with the Pen Tool  166
Non-destructive Editing  168
Exercises

1.	 Set Up the Collage Workspace  170
2.	 Trace an Image Contour with the Pen Tool  172

Screencast 8-1: Tracing with the Pen Tool  172
3.	 Modify Paths  177
4.	 Convert a Path to a Selection to a Layer Mask  180
5.	 Scale, Adjust, and Organize  183
6.	 Copy a Layer to an Open Document  184
7.	 The Magic Wand  186
8.	 Select, Copy, Paste, Repeat  190

Screencast 8-2: Duplicate, Transform, Burn, Organize,  
and Adjust—Ants in the Hand  193

Lab Challenge  193

CHAPTER 9: PROTOTYPING EXPERIENCES FOR MOBILE 
AUDIENCES  •  195
Screen Resolution  198
Getting Started with XD  198
Exercises

1.	 Articulate the Design Challenge  199
2.	 Set Up Artboards  200
3.	 Additional Visual Design  204
4.	 Connect the Prototype Screen  207
5.	 Test and Share  211

Lab Challenge  212

Contents  vii

Sam
ple

 p
ag

es



SECTION 4:

TYPOGRAPHY
CHAPTER 10: TYPE AND IMAGE  •  223
Contrast and Rhythm  224
Text Boxes  227
Text Adjustments: Kerning and Leading  227
Exercises

1.	 Define a Color Mode, then Place and Relink an Image  230
2.	 Add a Text Box  232
3.	 Resize and Kern Display Type  234
4.	 Replace Type with an Image  239
5.	 Add Vector Shapes to Frame the Composition  242
6.	 Final Design Adjustments  244

Screencast 10-1: Hiding Page Elements with a White Shape  
or a Clipping Mask  247

Lab Challenge  247

CHAPTER 11: THE GRID  •  249
Gestalt  250
Swiss International Style  252
Sentences and Paragraphs  253
Exercises

1.	 Alternative Paper Sizes  258
2.	 Guides and the Grid  259
3.	 Create Your Own “Virtual Leading” Spacers  261
4.	 Using Your Virtual Leading  264
5.	 Placing Another Guide on the Grid  266

Screencast 11-1: Using the Grid  270
6.	 Use the Grid  270
7.	 Save a PDF with Trim Marks  272

Lab Challenge  273

CHAPTER 12: CONTINUITY  •  275
The Gestalt Laws of Similarity and Continuity  276
0:00:00:00  279
Reading on the Screen  280
Inspiration Everywhere, Even Right at Home  281
Exercises

1.	 Video Terminology and the Adobe Premiere Pro Workspace  283
Screencast 12-1: Create a New Premiere Pro Project  
and Import Media  283

2.	 Build a Composite Sequence with Images and Sound  287
Screencast 12-2: Exporting Still Images from a Sequence in the  
Timeline Panel and Import Files to a Bin  287

3.	 Adjusting Clips in the Timeline  290
4.	 Adding Effects and Sharing Attributes  293
5.	 Adding Type with Adobe Fonts  297

viii  FOUNDATIONS OF DIGITAL ART AND DESIGN WITH ADOBE CREATIVE CLOUD

Sam
ple

 p
ag

es



6.	 Working with Keyframes  299
7.	 Add New Tracks  302

Screencast 12-3: Modifying Keyframes  303
8.	 Your Turn!  303
9.	 Fade to Black and Export  305

Lab Challenge  307

CODA: REVISION PRACTICES  •  309
Clear, Open Communication and Accessibility  311
Pencilbox Studios: Mission Hospital  311
riCardo Crespo: Hot Wheels and Standing Meetings  317
Michael Demers: The Sky Is Falling (A Day in the Life…)  318
The League of Imaginary Scientists: In League with an Institution  320
Jovenville: Boardstorming  324
Conclusion  327

Index  328

Contents  ix

Sam
ple

 p
ag

es



THE EXERCISES IN this chapter will provide technical lessons using 

Adobe Photoshop and Adobe Lightroom Classic and teach you to 

match textures and values to create photographic illusions in two 

compositions. You’ll explore various tools for healing and cloning 

parts of an image, as well as add a simple layer mask to blend image 

features for a quality of verisimilitude.

REPAIRS AND HOAXES
CHAPTER 7

145

Sam
ple

 p
ag

es



DIGITAL REPAIRS
The repair tools are stacked in a series in the Photoshop Tools panel, starting 
with the Spot Healing Brush tool beneath the Eye Dropper tool. The tools I 
use most often to make repairs are the Spot Healing Brush tool and the Clone 
Stamp tool. The Patch tool can be hard to control or predict, and the Red Eye 
tool does what you think it does. (It’s certainly useful.)

The Spot Healing Brush tool functions as a fix-it paintbrush. You simply click 
any part of the image, and the brush attempts to repair (or correct uneven 
tones in) the area based on a sample of nearby pixels. Of course, it’s never a 
good idea to modify your original image. So when using these tools, I recom-
mend copying the background layer to preserve the original file. You’ll learn 
more about non-destructive editing in Chapter 8, Select, Copy, Paste, Collage.

The Clone Stamp tool is also a brush. Cloning is a two-step operation: Photo
shop needs to understand what you’re cloning and where the clone should 
be applied. So you’ll need to sample an original source (the what part of the 
question) and then brush the sample into a new location (the where part). The 
sampling part of the Clone Stamp operation can sometimes be tricky to learn, 
but once you master the tool you’ll be able to repair just about anything.

Before Photoshop, artists manipulated images during the photo shoot, in the 
darkroom, or on the print, for instance, with SpotTone, a specialty ink used 
to correct or fill in white areas of photographs for dust spots. This seems like 
a lost art now that basic photo repairs can be made so quickly using software. 
However, manipulating photographic imagery has ethical implications for 
photojournalists and media contributors in the digital age. For instance, the 
National Press Photographers Association (NPPA) Code of Ethics includes the 
following statement:

“Editing should maintain the integrity of the photographic images’ content 
and context. Do not manipulate images or add or alter sound in any way that 
can mislead viewers or misrepresent subjects” [1].

Instances of photo manipulation to “get a better shot” have led to firings (for 
instance, Bryan Patrick from the Sacramento Bee) and loss of credibility (the 
infamous National Geographic cover of the Egyptian pyramids in 1982 where 
a horizontal image was smooshed into a vertical cover space). They’ve also 
led to increased criticism within the field. Take a look at two shots of O. J. 
Simpson published in June 1994 by Newsweek and Time magazines: the Time 
photograph was manipulated to make Simpson’s skin appear darker than it 
actually is.

LINK  For more informa-
tion on the repair tools in 
Photoshop, see the Adobe 
Photoshop help page: helpx.
adobe.com/photoshop/
using/retouching-repairing-
images.html.

HEALING BRUSH  This 
tool is essentially a 
combination of the Spot 
Healing Brush tool and 
the Clone Stamp tool: It 
lets you sample a source 
and tries to even out 
adjacent tones and blem-
ishes based on nearby 
pixel information.

REFERENCE [1]   
See nppa.org/code-ethics.

You can see both images 
of O. J. Simpson on the 
cover of the two maga-
zines side by side in the 
entry “O. J. Simpson 
murder case” on 
Wikipedia.
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WHAT IS ETHICAL IN REGARDS TO DIGITAL MANIPULATION?

In the “Changes to Photographs” section of the NPPA Special Report: Ethics in the Age 
of Digital Photography, Rev. Don Doll, S.J. is credited for the following ideas: “There 
are technical changes that deal only with the aspects of photography that make the 
photo more readable, such as a little dodging and burning, global color correction, 
and contrast control. These are all part of the grammar of photography, just as there 
is a grammar associated with words (sentence structure, capital letters, paragraphs) 
that make it possible to read a story, so there is a grammar of photography that 
allows us to read a photograph. These changes (like their darkroom counterparts) 
are neither ethical nor unethical—they are merely technical.” (See www.nppa.org/
node/5127 for more information.)

CREATING A HOAX
Although visual reporters need to handle digital manipulations with caution 
and care, artists often use these tools to create commentary on popular media 
and historic subject matter. For instance, Josh Azzarella’s still and video 
works use manipulation to revise historic events by way of deletion. In his still 
image, Untitled #15 (Tank Man), Azzarella re-creates the scene from Tianan-
men Square, originally photographed by Associated Press photographer Jeff 
Widener. In Widener’s image, the man is face-to-face with several Type 59 
tanks during the Tiananmen Square protests of 1989. However, in Azzarella’s 
image, the tanks are removed, and the man is left isolated in the middle of the 
street, seemingly out of the way of danger (FIGURE 7.1). Similarly, Untitled #7 
(16mm) is an 11-second loop showing 
President John F. Kennedy driv-
ing near the grassy knoll but never 
experiencing the fatal bullet wound. 
The footage of JFK riding in the car is 
haunting for contemporary viewers 
who know where the drive leads, 
even though it never quite gets there 
[2]. These examples of revision and 
manipulation aren’t meant to hoax 
or deceive the viewer (after all, we 
know what the artist is up to), but 
the strategies for image manipula-
tion are the same as those used to 
create a photographic hoax, which 
you’ll do in Exercises 4 and 5.

REFERENCE [2]  See Josh 
Azzarella’s videos on his 
website: www.joshazzarella.
com. 

FIGURE 7.1  Josh Azzarella, Untitled #15 (Tank Man). This image is a single 
frame in Azzarella’s video. Image appears courtesy of the artist.
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WHAT YOU’LL NEED
Download the following source materials to com-
plete the exercises in this chapter:

✔✔ The chapter07-workfiles.zip file which includes 
repair-start.psd and hoax-start.psd in the 
chapter07-start folder.

✔✔ Alternatively, you can download the two 
photographs you’ll need for this chapter from 
their source repositories online (see the sidebar 
Downloads). Save them in a folder named 
chapter07.

You’ll benefit from the ability to see changes in 
values and textures across all areas of the image.

WHAT YOU’LL MAKE
In the exercises in this chapter, you’ll repair 
a dusty portrait of JFK (FIGURE 7.2) and create 
an “extra finger” mummy hoax (FIGURE 7.3). The 
repairs and hoax share the aesthetic quality of 
verisimilitude—they deceive the viewer into believ-
ing your manipulated version of reality.

FIGURE 7.2  A portrait of President John F. Kennedy before and after digital repairs.

Image credits for the source photographs President John F. Kennedy, head-and-shoulders portrait, facing front (1961) appears 
and is used in this chapter courtesy of the Library of Congress [LC-USZ62-117124]. Hand of Guanajuato Mummy appears and is 
used in this chapter courtesy of Tomás Castelazo.

FIGURE 7.3  A mummy hoax includes an extra finger.
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DOWNLOADS: HIGH-RESOLUTION IMAGES FROM THE LIBRARY 
OF CONGRESS WEBSITE AND WIKIMEDIA COMMONS

1.	 The photograph of President John F. Kennedy is available on the Library of Con-
gress website—search for image LC-DIG-ppmsca-38698 on loc.gov. Beneath the 
thumbnail of the image on the left side of the page, you’ll see a link to download 
the 32.1 MB TIFF file of the image. This is the largest image available, and it’s the 
one you should download, because you can always scale down but you can’t add 
pixels. 32 MB is a large black-and-white file! It’s approximately 17 by 21 inches at 
300 DPI. I downloaded this image and then scaled it down to 9 inches vertically at 
300 DPI for the repair-start.psd file that I’ve included in the files on the compan-
ion site. If you want your brush sizes to match mine during the exercises, do the 
same or use the files on the companion site.

2.	 The file Placid death.jpg is available from Wikimedia Commons. The highest 
resolution file can be downloaded by clicking the “Original file” link that appears 
beneath the image on the file page. If you click the image itself to open it in a 
separate window, you’ll view the largest image. Then you can right-click the 
image (Control-click on older Macs) to open a contextual menu from which you 
choose Save Image As to download the image. Download the original file and save 
it as hoax-start.jpg.

EXERCISE 

1 REMOVE DUST AND HEAL JFK’S  
BLEMISHES WITH THE DEVELOP PANEL  

IN ADOBE LIGHTROOM CLASSIC
There are multiple ways to repair skin tones with digital tools. In this exercise, 
you will use the Spot Removal tool in Lightroom Classic. In Exercise 2, you will 
use similar tools in Photoshop.

PUBLIC DOMAIN AND CREATIVE COMMONS LICENSED IMAGES

To begin the exercises in this chapter, you’ll use two images that are, for different reasons, free to you. The portrait 
of JFK has two listings that let me judge that the image is in the public domain:

•	 Rights Advisory: No known restrictions on publication.

•	 Notes: U.S. Navy photo.

Because there are no known restrictions and this was a U.S. Navy photo (and government media is typically in the 
public domain), I have assessed that the image is fair to use. Also notice that the Library of Congress includes the 
following in red letters: “Rights assessment is your responsibility.”

The mummy image is licensed under the Creative Commons Attribution-Share Alike 2.5 Generic license. Because 
the image has a Share-Alike component (and this book is not licensed with a CC-BY-SA license, as it would be writ-
ten in shorthand), I contacted the author for permission to use the image.
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1.	 Launch Adobe Lightroom Classic, and import the repair-start.psd file to 
your Lightroom library. Make sure the Add option is active before you click 
the Import button.

2.	 Double-click the image preview, and change the module from Library to 
Develop by clicking the Develop button in the Module Picker at the top of 
the screen (FIGURE 7.4).

3.	 The tonal range and contrast in this photograph do not appear to need 
significant adjustments, however digital artists often touch-up portraits 
to soften wrinkles, even skin tones, and remove blemishes. Zoom in on 
JFK’s face either with the mouse wheel (or touchpad) or by pressing the 
Command-+/Ctrl-+ keys. Inspect the surface of the skin, looking for places 
where wrinkles appear to be especially deep as a result of shadow/high-
light contrast. Also look for spots or blemishes. Load the Spot Removal tool 
from the set of buttons beneath the Histogram (FIGURE 7.5).

See Chapter 6 Exercise 5 
to learn about importing 
images to Lightroom 
Classic.

FIGURE 7.4  Open the 
repair-start.psd file in the 
Adobe Lightroom Classic 
Develop module.

FIGURE 7.5  Load the Spot 
Removal tool in Lightroom 
Classic.
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4.	 Notice the Brush options that appear beneath the Spot Removal tool when 
this tool is loaded. This tool operates like a brush: It has controls for its 
size, feather (that is, edge sharpness), and opacity. You can work with this 
tool in Clone or Heal mode. If you are cloning, you need to sample a source 
to clone from before you begin brushing with the tool. If you are healing, 
simply click with the brush and Lightroom Classic will work its magic 
by automatically selecting a source based on a similar area of the image 
according to its tone and texture. Be sure that Heal mode is selected as you 
will work with the brush in this mode in the next steps (FIGURE 7.6).

5.	 Practice zooming in and out and moving the image around in the appli-
cation window. I use hot keys for all of this, as when I use my trackpad 
or mouse wheel (or a touchpad), I often end up resizing the brush by 
accident. I use Command-+ and Command-– to zoom (Ctrl-+ and Ctrl-– for 
Windows users), and I press the Spacebar to engage the Hand tool, which 
I use to move the surface of the image around. When I am repairing or 
modifying the image data, like you are about to do in this step, I like to 
see that information in detail, which means that less of the image appears 
on screen at once. You will quickly develop kinetic memory in your hands 
to change the zoom level and location of the image on the screen without 
having to look down. While the image of JFK’s face fills the screen from his 
forehead to his lips, look for a dark spot on his cheekbone (his left, your 
right side). Move the Spot Removal tool so the brush hovers over this area. 
Is the brush too small, too large, or just the right size for repairing this 
dark spot? The circular brush tip should be just a little larger than the spot. 
Mine happened to be exactly the same size as the spot, so I increased my 
brush by about 15 pixels. I did not use the Size slider in the Brush panel, 
instead I used the key commands. Press the Left Bracket ([) key to decrease 
the size of the brush and the Right Bracket (]) key to increase its size. When 
the brush size is set correctly, click the dark spot (FIGURE 7.7).

FIGURE 7.6  Set the Spot 
Removal brush to Heal.

FIGURE 7.7  Click the Spot Removal tool on a dark spot or blemish to replace it with similar tones selected from another part of 
the image. Use a brush size that covers the spot.

HAND TOOL  Use the 
Hand tool to move the 
image around the screen 
while you’re zoomed in. 
You’re not moving any 
part of the image file; 
you’re simply changing 
your view when you use 
the Hand tool. Access 
this tool by pressing the 
spacebar. This tool is 
useful in many Adobe 
applications, including 
Lightroom Classic, Pho-
toshop, and Illustrator.

ZOOM TOOL  You can 
easily access the Zoom 
tool while working 
with most other Adobe 
Creative Cloud applica-
tions by pressing the 
Command/Ctrl keys with 
the Equal or Minus key. (I 
always think of zooming 
in as Command-+ even 
though the Shift key is 
not involved).
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6.	 Did the spot disappear? Are you happy with the tonal adjustments 
Lightroom Classic, selected for you? You can still edit this spot because 
Lightroom edits are non-destructive. All of the information in the original 
image is preserved, and modifications made in the Develop panel are 
saved separately. In addition to your repair, you should see two circles con-
nected by a thin arrow on top of the image. One circle shows the location 
Lightroom chose to sample repair information for the dark spot. The arrow 
grows from this circle to another one. At the end of the arrowhead is the 
second circle, where you made the repair. Notice how the Spot Removal 
tool’s appearance changes depending on where you place the pointer on 
the image. When you hover the tool over either of the circles, it changes to 
a hand pointer. In all other parts of the image, the circular brush remains 
active for the tool, so you can repair or remove additional spots. Click the 
circle over the dark spot you just removed. Modify the brush settings; they 
are still active, even after you used them. Change the Size, Feather, and 
Opacity settings by dragging the sliders all the way to the left and right 
extremes, just to see how these adjustments control the results of your 
repair, and then use your best judgment to set them properly. I ended up 
leaving my settings as seen in the third part of FIGURE 7.8.

7.	 You can also move the circle that accounts for the sampled part of the 
image to see different results from the Spot Removal tool. Use the Spot 
Removal tool, again with the brush set to Heal to drag a line over the 
darker wrinkle across the middle of JFK’s forehead (FIGURE 7.9). You’ll 
modify the results in the next step.

FIGURE 7.8  When the brush is too large (above) or too small (top 
right), your image edits will draw more attention to the spots you 
are trying to hide. When the brush is the right size (right), you 
should consider adjusting the feather and opacity until the new 
image information fools the eye.
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8.	 Wrinkles should not be completely erased. If your Opacity was set to 100 
you will have replaced them with smoother skin and you should adjust the 
opacity downwards. If your brush was too large, you may have sampled 
the other wrinkles across his forehead, which could have left you in a bit 
of a mess. Now you should modify the brush options while the area you 
just painted across is active. (If you deselected it, click the circle attached 
to the area where you made an adjustment.) I changed the Opacity value 
to 40, then I moved the sample source to a lower part of the forehead by 
dragging the circle at the blunt end of the arrow (FIGURE 7.10).

FEATHER  You will find a numeric field or slider to control the Feather value in various 
parts of such Creative Cloud applications as Lightroom Classic and Photoshop. In all 
cases, this refers to how sharp an edge should appear. When you are using the Spot 
Removal in combination with Heal mode or the Healing Brush in Photoshop, you will 
probably choose a small number for the Feather option because you do not want the 
brush edges to be visible. When you are cloning, however, you may want to start with no 
amount of feathering so that you clone pixel information precisely. Then you may return 
to the clone area with some amount of feather applied to the brush to blend the results.

FIGURE 7.9  The Spot 
Removal tool can be drawn 
in a line over large areas 
for repair. Be extra attentive 
to the Opacity and Feather 
settings in these cases. 

FIGURE 7.10  The location of the sample source can be adjusted once you have made a repair.
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FIGURE 7.11  When the Tool Overlay option is set to Always, it is 
easy to see all of the locations where repairs have been made.

FIGURE 7.12  Changing the Tool Overlay option to Never allows 
you to see results of the repairs you made without being dis-
tracted by the interface.

9.	 Continue working with the Spot Removal tool set to Heal on the entire 
image, including the dust in the negative space around JFK’s head and the 
bags beneath his eyes. Choose the Tool Overlay option Always to see all 
of the locations where you have modified the image (FIGURE 7.11); choose 
Never to see the results of your work (FIGURE 7.12).

10.	When you are finished, click the Done button in the lower-right side of the 
image window (FIGURE 7.13).

11.	Choose File > Export to save a file with all of your adjustments. In the 
Export One File dialog box, choose Export To: Hard Drive from the first 
menu. In the Export Location section of the dialog box, choose Same 
Folder As Original Photo from the Export To: menu, and in the File Nam-
ing section, choose Filename-Sequence from the Rename To: menu. You 
should see a preview of the file name, repair-start-1.jpg (FIGURE 7.14). Click 
the Export button.

FIGURE 7.13  Finish your 
repairs, and click the Done 
button.

TOOL OVERLAY  In the 
Toolbar at the bottom 
of the image is the Tool 
Overlay menu. This lets 
you control the visibility 
of tools, depending on 
what you are working on. 
If you leave it on Always, 
you will always be able 
to see the circles created 
by the Spot Removal 
tool. This can be help-
ful for being able to 
select them and modify 
them. At other times, 
you may want to change 
the menu to Selected or 
Never, because it can be 
difficult to see the results 
of the tool in the context 
of surrounding pixels 
when a white trace line 
interrupts your view. 
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12.	Quit Lightroom Classic as you will work in Photoshop next.

EXERCISE 

2 �JFK’S EYES: TONAL REPAIRS  
WITH DODGE AND BURN

Now you’ll focus on repairing the eye area. Because you’ve already done a 
once-over with the Spot Healing Brush tool for dust, scratches, and major 
blemish repairs, you’ll do this additional, localized work on a new layer in 
Adobe Photoshop. In this exercise, you’ll modify a copy of JFK’s eyes with 
the Dodge and Burn tools. If you’ve never printed a negative in the darkroom, 
the analogy between this tool and common darkroom practices might not be 
intuitive. Dodging reduces the amount of light a print is exposed to during 
image processing in a darkroom, while burning adds additional exposure time 
(remember that the more light that hits a patch of photographic paper, the 
darker it becomes). Sometimes a negative needs a full exposure in all areas 
except for one (for instance, around JFK’s eyes—beneath his eyes he had dark 
rings and his eyebrows are so light they barely register). Photographers dodge 
prints during the image processing by blocking exposure light on a certain 
area (or areas) of the paper (to keep them lighter) or by blocking nearly the 
entire exposure with the exception of a small area in order to “burn” it in (and 
darken it). In turn, these small portions of the print receive less or more light 
in comparison to the rest of the projected imagery. When burning an area of 
the sensitized paper during an exposure to light in a black-and-white wet lab, 
for instance, a common exposure time for the adjustment might be about 5 to 
10 percent of the total exposure. So, in Photoshop, you might start with the 

FIGURE 7.14  Export the file 
containing image repairs to 
the same folder as the orig-
inal folder with a sequence 
number.
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Exposure value set at 5% or 10% in the Burn tool options. Of course, this value 
varies from negative to negative (or file to file), so it’s common to make a best 
guess when using this tool in combination with Command-Z/Ctrl-Z.

1.	 In Adobe Photoshop, open repair-start-1.jpg, which you just exported from 
Lightroom Classic. If you skipped this first exercise, open repair-start-1.jpg 
from the chapter07-start folder in chapter07-workfiles.zip available on the 
companion website.

2.	 Select the Lasso tool from the Tools panel (FIGURE 7.15). This tool lets you 
make a free-form selection around any part of the image. It’s not a good 
tool to use when you need to perform a precise selection, but it’s perfect 
for quickly isolating a general area of the image.

3.	 Draw a loose circle all the way around the left eye area, including a bit 
above the eyebrows. Be sure to begin and end the selection at the same 
point so that Photoshop knows the complete area of the selection. You’ll 
see flickering dashed lines surrounding the selected area, often referred 
to as “marching ants.” Now you’ll add a selected area around the right 
eye to the current selection. Press and hold the Shift key while drawing a 
circular shape around the right eye area with the Lasso tool—the tiny plus 
sign near the bottom of the tool shows that you’re adding to the current 
selection. You should have two sets of marching ants on the image, one 
surrounding each eye (FIGURE 7.16).

4.	 Copy the selected eye area and paste it using the keyboard shortcuts 

Command-C/Ctrl-C then Command-V/Ctrl-V. In the Layers panel, rename 
the new layer eyes. Choose File > Save As to save the PSD file to your hard 
drive. I named mine repair-end.psd and put it in my results folder.

WORKSPACE  Choose 
Window > Workspace > 
Photography for the 
remaining exercises in 
Photoshop.

KEYBOARD SHORTCUTS   
When copying and past-
ing from one layer to 
another, an alternative to 
Command-C/Ctrl-C and 
Command-V/Ctrl-V is to 
use the single command 
Command-J/Ctrl-J to 

“float” the selected area to 
a new layer.

FIGURE 7.16  Start and end 
the selection with the Lasso 
tool at the same location 
in the image. Press and 
hold the Shift key to add 
to an active selection. The 
“marching ants” show a 
selection around the eye 
area.

FIGURE 7.15  The Lasso tool 
is grouped with other selec-
tion tools.
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SCREENCAST 7-1  ADDING AND DELETING WITHIN SELECTIONS

You can add to any selection using one of the Photoshop selection tools by press-
ing the Shift key. If you want to add extra area to an existing selection, you’ll have 
to begin the “new” part of the selected area from within the existing selection. If you 
want to subtract part of an existing selection, press and hold the Option/Alt key while 
starting the “deleted” area of the selection from outside the existing selection. This is 
much more easily understood by seeing it demonstrated than by reading text. For a 
demonstration, view the screencast for this chapter.

All screencasts are available on the companion website, www.digitalart-design.com or on 
the Vimeo playlist, bit.ly/foundations-demos.

5.	 The bags beneath his eyes were too dark before you lightened them with 
the Spot Removal tool in Lightroom Classic. In opposition to this, his eye-
brows (especially his left brow) are so light they barely register. Because 
you already corrected for the skin tones under his eyes in Lightroom, load 
the Burn tool to darken the brows (FIGURE 7.17).

6.	 Glance at the Layers panel. Nothing should have changed there; you 
should be working on the eyes layer. (Click it to make it active if you 
noticed that another layer is active.) Always look at the tool options, espe-
cially before using a new tool. There are many options for the Burn tool. 
For now, notice the Brush Preset picker menu, the Range menu (choose 
Highlights), and Exposure control (set that to 10%). There are other 
options, too, including the option to enable airbrush style build-up, the 
Protect Tones checkbox, and an icon that allows the pressure to determine 
brush size when using a stylus pen. Open the Brush Preset picker menu, 
and make sure that the Hardness level is set to zero, as you’ll want your 
brush to have a soft edge to allow the burning results to feather or blend 
into the image. Place your pointer over the eyebrow and use key com-
mands to adjust its size so it covers the eyebrows where they are largest 
(Left Bracket key or Right Bracket key, just like in Lightroom). Now you 
need to estimate a reasonable exposure value. The general rule is that you 
can always brush these tools over an area more than once, so it’s better 
to err on the side of a lower value. Play with the exposure value (I ended 
up using 10%), and make a quick brushstroke over JFK’s left eyebrow 
to darken it (FIGURE 7.18). Zoom out to 100% to evaluate your results. I 
brushed twice over the left brow and once towards the end of the brow on 
the right side of the image. The modification should not be extreme. Your 
modification should be believable!

Keep a copy of the 
original file in the Layers 
panel when working on 
repairs. Naming your 
layers as you work will 
keep the panel organized 
and help you work effi-
ciently as the size of the 
list increases.

FIGURE 7.17  The Burn tool 
is grouped with the Dodge 
and Sponge tools. These 
tools alter the tonal values 
and intensity of the hue in 
an image.

POINTER IMAGE  If 
you don’t see a circle 
representing the size of 
the brush in Photoshop, 
check your Photoshop 
preferences. The brush’s 
appearance is set in 
Photoshop > Prefer-
ences > Cursors/Edit > 
Preferences > Cursors. 
Choose Normal Brush 
Tip. Also, make sure 
your Caps Lock key is 
not depressed. Engaging 
Caps Lock will change 
the pointer image to a 
cross-hair.
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COPYING IMAGE PARTS

Be extra attentive to the Layers panel when copying selected parts of an image. It’s 
common for new users to attempt to copy part of the image that they can see, but 
that isn’t actually on the selected layer. If you do this, you might get an error message 
stating “Could not complete the copy command because the selected area is empty.” 
This happens to everyone at some point during image manipulations. Simply click OK 
to exit the warning dialog, and then activate the appropriate layer before attempting 
to copy again.

FIGURE 7.18  Touch up the 
brow area with the Burn 
tool. Adjust your settings so 
you need to brush over this 
area of the image only once 
or twice.

Why not use the Spot 
Healing Brush tool here? 
You could work with the 
Spot Healing Brush tool 
to correct the eyebrows, 
but the trouble here is 
not the pixel informa-
tion, just the value of the 
highlight tone. In this 
situation, correcting the 
tones by burning and 
dodging will maintain 
the integrity of the image.

HISTORY IS FULL OF REVISIONS

Repairs will inevitably lead you to over-click with tools such as the Healing Brush or the Dodge and Burn tools 
in the Photoshop file. It’s easy to become click-crazy in the process. Familiarize yourself with the History panel, 
as you’ll come to rely on this handy Photoshop archive. There are three things you need to know about using the 
History panel:

•	 Access the History panel from Windows > History or the History icon in the column of panels on the right side 
of the Application window.

•	 By default, Photoshop may save only 20 or 50 of your previous clicks or steps. You’ll want to increase this when 
doing repair work. Choose Photoshop > Preferences > Performance/Edit > Preferences > Performance. On the 
right side of the dialog box, enter 99 in the History States field. The more clicks or previous states you save, the 
more RAM you’ll use. If your computer is slow or lacking RAM, you may want to skip this step.

•	 To go back a step or two, or five, click once on the name of each of the previous steps in the History panel until 
your file appears in the state at which you want to begin working anew. There’s nothing else you need to click. 
Simply begin working again, and the History panel will create new steps, overwriting the dimmed step or steps 
that you’re leaving out of your process.
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7.	 Review your modifications at actual size by using the keyboard short-
cut Command-1/Ctrl-1. Click the eyeball icon next to the eyes layer in 
the Layers panel to hide and show the layer (FIGURE 7.19). If you have 
gone too far, you can reverse your way back through your actions using 
Command‑Z/Ctrl-Z or the History panel (see the sidebar). When you are 
finished adjusting the eye area, save your work and close the file.

FIGURE 7.19  Making the 
eyes layer alternately 
invisible (top) and visible 
(bottom) helps preview 
repairs. You can easily see 
your repairs by clicking 
the Eyeball icon on and off 
in the Layers panel.
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EXERCISE 

3 �IT’S A HOAX! ADDING AN EXTRA  
MUMMY FINGER

In this exercise, you’ll add an extra mummy finger using the Clone Stamp tool. 
This tool functions similarly to the Spot Repair tool in Lightroom Classic and 
the Healing Brush tool in Photoshop, but you’re responsible for selecting the 
location of the source area before making repairs. You’ll work with a hard-
edged and soft-edged brush in this exercise. In the next exercise, you’ll clean 
your work with a layer mask.

1.	 Open hoax-start.psd in Photoshop. Continue to work in the Photography 
workspace.

2.	 In the Layers panel, click the Create A New Layer icon. Unless you clicked 
the icon more than once, the layer’s default name is Layer 1. Rename 
it finger. You now have an empty layer named finger above the locked 
Background layer in the Layers panel.

3.	 Select the Clone Stamp tool from the Tools panel (FIGURE 7.20). View the 
Options bar. I set my brush to 250 pixels and changed the Hardness value 
to 85%. Because you’ll be copying pixels with this tool, you’ll want to use 
a brush that isn’t too soft. The soft edges often blur the pixel information, 
which you want to keep sharp, at least during the copying portion of this 
process. Keep the Mode set to Normal, leave the Opacity and Flow at 100%, 
check the Aligned box, and set the Sample menu to All Layers (FIGURE 7.21). 
Remember, you’ll first sample with this tool and then clone. If you check 
the Align box, you’re telling Photoshop to keep the sample area aligned 
with the cloning area. You’ll see that it makes sense to keep the source and 
clone aligned. 

FIGURE 7.20  The Clone 
Stamp tool is grouped with 
the Pattern Stamp tool in 
the Tools panel.

FIGURE 7.21  Brush settings are in the Options bar. The brush hardness is set to 85%. You can 
also see the other tool options set for cloning in this exercise.
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4.	 Zoom in using the same key commands as in other Adobe 
applications, such as Command-+/Ctrl-+. Make sure the 
finger layer is active; this is where you want to place your 
cloned finger. Place the Clone Stamp tool (which basically 
functions as a brush with an extra sampling step) on top 
of the last knuckle. Press the Option/Alt key, and click just 
once in this location (FIGURE 7.22). Don’t drag the mouse. 
You just told Photoshop that this is the area that you want 
to sample as you clone the new finger, and because the 
option for Sample is set to All Layers, you are allowed to 
sample from whatever parts of the image this brush covers, 
on any of the layers. There is nothing to sample on the 
finger layer, so the Clone Stamp tool will sample from the 
mummy finger on the Background layer. 

5.	 Move the mouse to the right of the last knuckle and down 
a little bit to align it with a plausible location for a new 
knuckle (FIGURE 7.23). The Clone Stamp tool provides a 
preview of what the cloned image will look like in your 
composition so you can get the alignment just right before 
committing to a click. Click and drag downward, trac-
ing the finger, until you reach the end of the fingernail 
(FIGURE 7.24). Save the file as hoax-end.psd, which you’ll 
update at the end of the next exercise.

Congratulations! You just added a sixth finger to a 
mummy. In the next exercise, you’ll clean the cloned image 
data to make the new finger blend with the rest of the 
composition.

FIGURE 7.22  Sample from 
the mummy’s knuckle with 
the Clone Stamp tool. Check 
to make sure the finger 
layer is active.

FIGURE 7.24  The new finger in position. The 
brush hardness ensures that pixels are sam-
pled accurately.

FIGURE 7.23  Paint a new finger using the Clone 
Stamp tool aligned next to the sampled finger.
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EXERCISE 

4 SOFTENING CLONED EDGES

Fingers don’t stay the same size from the knuckle to the nail, so because 
there are extra parts of the cloned finger that obstruct the view of the original 
composition, the viewer can tell that the image has been manipulated. In this 
exercise, you’ll use a layer mask to hide extra parts surrounding the cloned 
finger. Consider this exercise to be a brief introduction to the layer mask. You’ll 
learn more about layer masks in the next chapter.

1.	 In the Layers panel, activate the finger layer and then click the Add Layer 
Mask button (FIGURE 7.25). You’ll see a new icon in the Layers panel: a white 
square next to the layer icon of the finger.

2.	 The layer mask is used to hide or show parts of a 
layer. Because the finger layer contains only the 
extra, cloned finger, the mask will affect only this 
image data. You could work with the Eraser tool 
to delete image data, but instead it is preferable 
to work non-destructively, to simply hide (rather 
than delete) pixels. Layer masks operate in white 
(show the layer content), black (hide the layer 
content), and shades of gray (partially hidden). 
Press B to select the Brush tool (or locate it nested 
with the Pencil tool in the Tools panel), and press 
X to load black into the foreground color chip 
(FIGURE 7.26).

3.	 View the Brush tool options. Set the Hardness 
value to 0, as you’ll want to use a soft-edged 
brush. Leave the Mode set to Normal and Opacity 
and Flow at 100%. You will adjust the size using 
the keyboard.

4.	 Before using the Brush tool, make sure that the 
mask is active in the Layers panel. You can click 
once on the layer content thumbnail or on the 
mask icon. Notice that whichever is activated is 
framed with white edges around its icon and near the file name (at the top 
of the document window) additional information confirms your location 
in the file’s organizational structure (FIGURE 7.27). When you’re sure that 
the mask is active, you are ready to set the size of the brush and then paint 
black around the edges of the finger where you want to hide the extra 
image details (FIGURE 7.28).

KEYBOARD SHORTCUT   
Because you’ll always 
work with white and 
black on Photoshop 
layer masks, you should 
remember that X is the 
hot key for swapping the 
foreground and back-
ground colors.

FIGURE 7.25  While the finger 
layer is active, click the Add 
Layer Mask icon to create a 
mask specific to this layer.

FIGURE 7.26  The Brush 
tool is selected with black 
loaded into the fore-
ground color chip.
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5.	 Notice that the layer mask now contains an abstract black painting on its 
white background. Option-click/Alt-click the layer mask icon in the Layers 
panel to show just the mask in your composition (FIGURE 7.29). The black 
areas of the composition are hidden. The white areas are revealed. Look 
for gaps between the black and white areas. You may want to review those 
parts of the composition and add more black or white paint to fill in the 
gaps. This is an easy way to clean the mask because you can easily see 
how the image details are being treated. Option-click/Alt-click the mask 
icon in the Layers panel again to resume the normal working mode and 
continue to modify the layer mask (FIGURE 7.30).

FIGURE 7.28  Extra image details are hidden by painting the mask black in those areas. Here you can see the black brushstroke 
on the layer mask icon.

FIGURE 7.27  Click the layer content icon or the layer mask icon to make adjustments to the layer or its mask. Notice how the 
information near the name of the file updates depending on which part of the file is activated.
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6.	 Remember to view the document at actual size and then save the file.

LAB CHALLENGE

Create a hoax! Modify a current news story by using the repair and clone tools 
you learned about in this chapter on a fictitious news image. In news photog-
raphy, the caption is important, too. Don’t forget to write a caption to accom-
pany your newsworthy image.

FIGURE 7.29  A view of the 
finger layer mask. The white 
areas are visible in the 
document. The black areas 
are hidden from view (or 
masked). Any gaps would 
be filled in with the Brush 
tool using black.

FIGURE 7.30  The mummy 
finger hoax is complete and 
visible in normal editing 
mode.
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